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Family Tree Maker Software Basics


Family Tree Maker is the world’s most popular genealogy tracking software. Several reasons are user friendly, easy to understand screens, many features including genealogy reports and family trees, Internet capable, book publishing capable, new updates annually, and cost economical. The features discussed are available in FTM Versions 2005 through 2007 (aka V16). Earlier versions don’t include the Internet, limited source info, and limited book publishing features.

The many FTM features can be overwhelming and requires additional explanation of using the FTM software effectively and efficiently to make your research easy to learn and understandable. This presentation covers the basics of the FTM software including several intermediate steps in completing your research and genealogy report. The Internet feature using Ancestry.com will be discussed in the afternoon class. 

FAMILY VIEW SCREEN

Let’s start with the family screen view as shown in Figure 1 below. Most people know how to input the research data provided by relatives, personal obtained documents, and using the Internet databases. There are five icons on this screen that should be used for each ancestor. 
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Figure 1.  FTM Family View Screen

The five icons relate to the [A] Source, [B] Edit, [C] Spouses, [D] Scrapbook, and [E] Web Search Resources. I’ll discuss each one in detail.

SOURCE ICON

The Source icon is for creating sources for each ancestor. This is one of the most important features and requirements for genealogists to use when researching their ancestors. Both primary and secondary source information should be listed here. The source document is always required to prove your ancestor’s relationship and providing dates. The source text box allows users to input their ancestor’s vital information and including the source information, ie, government or family documents as shown here in Figure 2 below.
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Figure 2. Source Text Box

Creating sources is easy starting with selecting a new source [A] New above. Users can select New for a Master or Individual only source, which users can always delete it by selecting [B] Delete. Master source information can be edited by selecting the [C] Edit button. Add the correct source information as shown in [D] box above. Then add the information and location of the source document in [E]. Be sure to list any book and page numbers for government documents. Finalize the source information by entering the citation summary of the source in [F].

You can add an image (jpeg photo or other format) of the document, provided you scanned it or took it from the Internet and select [F] image button. If you want to include the source information in a genealogy report or the Family group sheet, then check the [G] footnote box. If you need help on any of these items in the Source box, select the [H] Help button. To copy this source into other places onto the clipboard for later retrieval, select the [I] Copy and [J] Paste buttons. When done with the source information, select the [L] OK button.

EDIT ICON

The Edit icon includes adding family history information on each Ancestor in predefined templates as shown in Figure 3 below.
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Figure 3. Ancestor Edit Box

There are five tabs at the top of each edit box for each ancestor. The [A] General tab as shown above lists the vital facts of the ancestor. Users can also list the burial location on this screen as shown above. 

The [B] Facts tab allows users to enter other pertinent facts on the ancestor such as baptism, high school graduation, etc. as shown in Figure 4 on the next page. Listing more facts can help in providing a biography for the ancestor. More information on this important tab is listed on the next page.

The [C] Notes tab allows users to add any kind of notes for the listed ancestor. Notes can include biographical information or confidential information.

The [D] Medical history information can include any medical history on the affected ancestor. This is ideal if users want to trace medical problems through the ancestor’s generations. However, I recommend using in confidence, ie privacy and insurance company issues.

The [E] Address tab is for contacting relatives or for locating the last known address of an ancestor.

The [F] Married name format applies to married women only. There are three options listed as shown above. The preference is First Middle Maiden for any married woman. If users list the married name, then conflicts will occur.

After each name and date is another [G] Source button to review the same sources listed on the Family view screen.

The Facts tab allows users to enter more facts on each ancestor than shown on the Family view screen.  As shown below, additional facts have been entered with dates and locations or event. To the right are two columns for showing the number of sources and preference of the fact.
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Figure 4. Ancestor Facts Information

Additional facts can be added, edited, or deleted by selecting one of the [A] buttons shown above. As mentioned previously, adding more facts can help in creating a detailed biography, especially if you plan on writing a genealogy report or publishing a family history book. Users can select the [C] Notes tab or Notes window button to add a biography for the affected ancestor. Users can also add the source information for each fact listed above. After completing the facts section, then select [D] OK to exit.

SPOUSE ICON

The Spouse icon is important if you have more than one spouse for each relative, regardless of the gender. If any relative has two or more spouses, whether they had children or not, add in this box as shown in Figure 5 on the next page.

To create a new spouse select [A] button. A new text box will ask if existing children will be added to the new spouse. In most cases, answer is no, unless the children are adopted by the male. Select {B] on which spouse to be shown on the Family view screen by default. Users can select the other spouse by selecting the other spouse in this box. The preference is to select the spouse with the children, unless both spouses had children.
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Figure 5.  Create A New Spouse Text Box

Select [C] OK button to close and exit.

SCRAPBOOK ICON

When users are ready to add family pictures or graphic documents like picturesque marriage certificates to the scrapbook, then select the Scrapbook icon. Figure 6 below shows the scrapbook with several pictures already included.
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Figure 6. Ancestor Scrapbook

As shown above, users can add any type of photo or other picture to the scrapbook. I’ve included several photos of my ancestor plus a penny postcard of the locations he lived or worked at during his life.

Users need to enter photos into the scrapbook before any photo can be attached to family trees, family group sheets, or for book publishing. I recommend scanning ancestor photos or asking relatives to send a photo via an email attachment. Add the photo to your computer’s My Pictures folder under My Documents folder (MS Windows computer operating systems). I suggest adding a new folder for genealogy pictures in the My Pictures folder with additional subfolders for each surname.

Important Note: All photos for the scrapbook should be scanned in uncompressed jpeg at 300dpi (dots per inch). Newspapers use 72 dpi for their photos, which is why their picture quality is not good. Cameras can be used to take photos, providing the lighting is used correctly. If jpeg compression can’t be changed, use Windows Bitmap or TIFF formats, however photo file sizes can be about 5 MBS. Normally, one to two MBS file size is acceptable for photos to be used for scrapbooking or for book publishing. If photos are dark, FTM has an internal photo editing program to lighten, crop or modify the photos by selecting [B] edit as shown in Figures 6 above and 7 below. For serious photo editing to do more touch up and remove scratches or other problems, a separate photo editing program is needed.

Start by selecting {A] Insert picture from file or optionally from your scanner or camera. Another box appears for scanning or from your camera, if you have the scanner or camera software available on your computer.
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Figure 7. FTM Photo Editing

The main features for photo editing within FTM are cropping, fixing red eye for color photos, and changing the brightness, contrast, or color saturation (B/W not applicable) of any photo taken for the scrapbook. Select OK button after correcting any of the edit items. The picture appears in the ancestor’s scrapbook as shown in Figure 6.

Right click on the photo in the scrapbook or select the icon on the photo in the scrapbook and select More About item as shown in Figure 8 on the next page. Users can add where the picture should appear, ie, family group sheets, family trees, scrapbook printing or other location. Be sure to add photo caption for genealogy reports or books. It’s also recommended to add the photo description in the box as noted below, such as location or event for later use.
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Figure 8. More About Photo Box

Select the OK button to close and exit.

CREATING FAMILY TREE CHARTS

Creating family tree charts in FTM is very easy. After your key vital information is entered for a specific family line of at least two to four generations, a family tree chart can be viewed and printed. Select the View menu for the selected relative or select the Tree Chart icon below the menu bar, then select the Tree Charts item and select sub-item Ancestor or Descendant Tree Chart Vertical or whichever one is required a shown in Figure 9 below.
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Figure 9. Descendant Tree Chart

Photos and other vital information can be included in each descendant ‘s box to make the family tree chart more appealing. However, too much information can make it confusing with too much detail. Users can vary the amount of generations shown, add borders or change colors by male or female or other category to make the tree more visual.

There are over 50 family tree charts that can be created from nine basic trees. Users can print small family trees on single sheets and tape together or have a professional printer print a large poster sized family tree or on a paper roll which can be hung on a wall for viewing the entire family. Costs vary, but check with multiple printers for the lowest price.

CREATING GENEALOGY REPORTS

Different types of genealogy reports can be created using the reports item under the View menu. A standard genealogy report, kinship relationship report, family group sheets, outline descendant chart, and various customized reports can be created. All reports can be customized with different information. An options toolbar will appear beside each report for users to customize the contents and look. Pictures can be added to the Family group sheets as shown in Figure 10 below, but not to any of the detailed reports. Only books can include pictures if needed.
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Figure 10. Family Group Sheet

BASIC PREFERENCES

Users can modify the icon toolbar on top for easier access to the different software features. Users can format in metric or English units or format the dates in different styles, change photo resolution for publishing, modify titles and labels for ancestors and descendants, or use different number systems for references in genealogy reports. Select the Preference item under the File menu bar at the top and select the customization required.

BACKUP AND RESTORING FILES

Users should always back-up family files to other areas inside and outside your computer. You’ve probably heard horror stories of year long family files being lost or destroyed because the user hit the wrong button or icon. Several options are to back-up your family files on another part of your hard drive. These become back-up files to the master file. Always add a date to your family files if you keep multiple family files on your computer. Saving your family file on a CD or USB Memory Stick is a must!

Restoring files is easy by selecting the File menu and selecting the Restore from Local Backup feature in this menu. But you must have a backup file for this feature to work.
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